
INTRODUCTION TO

Liquid & Gas Properties



C o n t a c t  I n f o r m a t i o n
Visit the Contact COMSOL page at www.comsol.com/contact to submit general inquiries or 

search for an address and phone number. You can also visit the Worldwide Sales Offices page at 

www.comsol.com/contact/offices for address and contact information.

If you need to contact Support, an online request form is located on the COMSOL Access page 

at www.comsol.com/support/case. Other useful links include:

• Support Center: www.comsol.com/support

• Product Download: www.comsol.com/product-download

• Product Updates: www.comsol.com/support/updates

• COMSOL Blog: www.comsol.com/blogs

• Discussion Forum: www.comsol.com/forum

• Events: www.comsol.com/events

• COMSOL Video Gallery: www.comsol.com/videos

• Support Knowledge Base: www.comsol.com/support/knowledgebase

Part number: CM025202

I n t r o d u c t i o n  t o  t h e  L i q u i d  &  G a s  P r o p e r t i e s  M o d u l e
© 1998–2022 COMSOL

Protected by patents listed on www.comsol.com/patents, or see Help>About COMSOL Multiphysics on the File 
menu in the COMSOL Desktop for a less detailed lists of U.S. Patents that may apply. Patents pending.

This Documentation and the Programs described herein are furnished under the COMSOL Software License 
Agreement (www.comsol.com/sla) and may be used or copied only under the terms of the license agreement.

COMSOL, the COMSOL logo, COMSOL Multiphysics, COMSOL Desktop, COMSOL Compiler, COMSOL Server, 
and LiveLink are either registered trademarks or trademarks of COMSOL AB. All other trademarks are the property 
of their respective owners, and COMSOL AB and its subsidiaries and products are not affiliated with, endorsed by, 
sponsored by, or supported by those trademark owners. For a list of such trademark owners, see www.comsol.com/
trademarks.

Version: COMSOL 6.1

www.comsol.com/patents/
https://www.comsol.com/sla/
http://www.comsol.com/contact/
http://www.comsol.com/contact/offices/
http://www.comsol.com/support/case/
http://www.comsol.com/support/
http://www.comsol.com/product-download/
http://www.comsol.com/support/updates/
http://www.comsol.com/blogs/
http://www.comsol.com/forum/
http://www.comsol.com/events/
http://www.comsol.com/videos/
https://www.comsol.com/trademarks/
https://www.comsol.com/trademarks/
http://www.comsol.com/support/knowledgebase/


Contents

The Thermodynamic Properties Database. . . . . . . . . . . . . . . . . . 5

Engine Coolant Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Model Definition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

Results  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8

Reference. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

Modeling Instructions: Engine Coolant Properties . . . . . . . . . . . . . 16

 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 52

Heat Pipe with Accurate Liquid and Gas Properties . . . . . . . . . 53

Model Definition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

Results and Discussion . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 56

References . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59

Modeling Instructions: Heat Pipe with Accurate Liquid and Gas 
Properties  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 59
 | 3



4 | 



The Thermodynamic Properties Database

This introduction booklet demonstrates the use of the built-in thermodynamic 
properties database in the Liquid & Gas Properties Module. The purpose of this 
database is to calculate thermodynamic and transport properties for pure solutions 
and mixtures of chemical compounds. Properties such as enthalpy of formation, 
heat capacity, thermal conductivity, density, and diffusivity can be computed using 
a range of models. These properties can be calculated for fluids consisting of a 
single gas phase or a single liquid phase and for liquid-liquid, vapor-liquid, and 
vapor-liquid-liquid systems. For multiphase systems, the equilibrium composition 
can also be calculated, for example, to calculate the phase envelope for a liquid 
mixture at equilibrium with its vapor phase (flash calculations).
• The first example in this booklet, namely Engine Coolant Properties, shows the 

use of the thermodynamic properties database in the investigation of a liquid 
coolant for internal combustion engines. A mixture of ethylene glycol and 
water is studied, and the built-in thermodynamics functionality is used to 
show how the boiling point, density, viscosity, thermal conductivity, and 
heat capacity all depend on the composition of the coolant mixture, and how 
changes in these properties affect the cooling process

• The second example considers a tubular Heat Pipe with Accurate Liquid and Gas 
Properties. A copper cylinder, with an inner cavity and a porous water 
saturated copper wick, allows evaporated water to flow from the hot end to 
the cold, depositing its latent heat. The effect of loss of working fluid is 
analyzed, and the relative importance of transfer of vapor at normal 
operating conditions is evaluated.

The thermodynamic properties database in the Liquid & Gas Properties Module 
can be combined with any module that deals with transport in fluids — for 
example, the CFD Module, Mixer Module, Heat Transfer Module, Pipe Flow 
Module, and Subsurface Flow Module.
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Engine Coolant Properties

Introduction
The engine block of a car includes a cooling jacket to remove excess heat from 
combustion. The cooling jacket consists of open spaces in the cylinder block and 
the cylinder head. When the engine is running, a coolant fluid is pumped through 
the jacket to keep the engine from overheating. Optimizing the heat removal is 
important to minimize coolant boiling, prevent engine failure, and, more recently, 
improve overall efficiency through waste heat recovery. This example 
demonstrates how the Thermodynamics feature can be used to evaluate the 
performance of different engine coolants.
Although pure water works well as a coolant, to prevent freezing at low 
temperatures, a mixture of ethylene glycol and water is normally used to lower the 
freezing point. The Thermodynamics feature is used here to show how the boiling 
point, density, viscosity, thermal conductivity, and heat capacity also depend on 
the composition of the coolant mixture and how changes in these properties affect 
the cooling process.

Model Definition
Figure 1 shows the flow pattern inside the cooling jacket of a representative four 
cylinder engine. Solving a fully coupled nonisothermal turbulent flow problem 
with temperature-, pressure-, and composition-dependent coolant properties in 
this complex geometry typically requires a significant number of computer hours. 
One approach to obtain a reliable approximate solution in a shorter time is to use 
the functionality available in the Thermodynamics feature to investigate the 
coolant property behavior and determine where simplifying assumptions can be 
made. The consequences of these assumptions can be investigated efficiently in a 
6 | 



simplified geometry in order to provide confidence in their use in more complex 
geometries.

Figure 1: The coolant flow inside the coolant jacket of a four-cylinder engine.

Here, a simplified 2D axially symmetric geometry, shown in Figure 2, is considered 
as an engine coolant test apparatus. Coolant is introduced at a specified flow rate 
in the bottom of the device, the coolant hits a solid steel part and is then deflected 
into a larger flow domain. A heat flux is applied on the outer boundary of the 
larger section. The resulting temperature is measured at steady state in the solid 
structure near the coolant outflow at the top. 
To solve for the fluid flow and heat transfer in the test apparatus, the current 
model uses the Single-Phase Flow and the Heat Transfer in Fluids interfaces. The 
interfaces are coupled using a Nonisothermal Flow multiphysics feature, and the 
k-ε model is used to model the fluid flow turbulence.
The properties of the coolant fluid are defined using the Thermodynamics feature. 
This is done by first defining and adding a Thermodynamic System node to the 
Thermodynamics feature. Included in the Thermodynamic System are the 
relevant chemical species, in this case ethylene glycol and water. The 
Thermodynamic system node in turn can be used to compute property functions 
for thermodynamic properties and transport properties, both for the pure species 
and for the resulting mixture. In this case, functions for the density, the viscosity, 
the thermal conductivity and the heat capacity of the coolant mixture are created. 
The analysis of the coolant properties is performed in three steps. First, the 
mixture properties are evaluated by plotting the functions created by the 
Thermodynamic System. Then the phase envelope of the coolant vapor-liquid 
system is visualized by plotting the equilibrium temperatures (for boiling and 
condensation) as a function of the composition. The required equilibrium 
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functions are defined by adding an Equilibrium Calculation feature to the 
Thermodynamic System. Using the equilibrium functions the phase envelope for 
two different pressures are compared. 
The fluid flow and heat transfer of the coolant mixture inside the test apparatus 
are then solved for. Results for pure water, and a 50 volume percent mixture of 
ethylene glycol in water are compared. For these chemicals, a 50 volume percent 
mixture corresponds to 52.7 mass percent of ethylene glycol. Finally the results are 
used to compute average mixture properties.

Figure 2: Axially symmetric engine coolant test apparatus.

Results
Figure 3 shows the temperature and composition dependence of the heat capacity. 
Similar graphs are generated for density, viscosity, and thermal conductivity. 
Studying these graphs reveals that the addition of ethylene glycol increases the 
density and viscosity, but decreases the thermal conductivity and heat capacity 
when compared with pure water. It should be expected that a 50 volume percent 
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mixture will yield a higher pressure drop and require a higher flow rate to achieve 
the same cooling effect as that of pure water.

Figure 3: Heat capacity as a function of temperature and composition for ethylene glycol water mixtures.

Figure 4 shows the phase envelope for ethylene glycol-water mixtures produced 
using the Equilibrium Calculation feature of the Thermodynamic System. A car 
coolant system typically operates at about 2 atm pressure. Here we can see that a 
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50 volume percent (24.4 mole percent) mixture should boil at a temperature 
slightly higher than 400 K at this pressure.

Figure 4: Phase envelope for the equilibrium temperature of ethylene glycol-water mixtures at two 
pressures.

Figure 5 shows the flow pattern inside the test apparatus with water entering at 
1 m/s. The coolant flow of 42 l/min and a heat input of 50 kW used here in the 
10 | 



test apparatus are on the same order of magnitude as in a conventional car cooling 
system.

Figure 5: Flow patterns inside the test apparatus with water at 1 m/s.

As expected, Figure 6 shows that an ethylene glycol-water mixture will provide less 
cooling than pure water at a fixed flow rate. About 15 percent more coolant flow 
is required to produce the same cooling as when using pure water. It can also be 
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seen that some boiling of the coolant (at T > 400 K) is expected in the 
recirculation zones in the outer corners of the apparatus.

Figure 6: Temperature within the test apparatus for three cases: (a) water at 1 m/s, (b) 50 volume 
percent ethylene glycol at 1 m/s, and (c) 50 volume percent ethylene glycol at 1.15 m/s.

a

b c
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The table below provides a comparison of results for pressure drop, outlet 
temperature, and outlet density.

1 Using constant mixture properties.
Considering the graphical results for the various coolant properties, it might be 
best to use approximate averages for the relatively small temperature range of 353–
400 K. In Figure 7 the resulting heat capacity for the pure water and the two 
ethylene glycol-water mixture cases is plotted. As seen before, the heat capacity 
differs significantly when comparing pure water and the mixture. But, the 
individual variation for each coolant however is seen to be small, about 2% for this 
mixture property and location. Analyzing the density in the same manner, the 
variation can be seen to be in the same order of magnitude.

Figure 7: Coolant heat capacity plotted along a vertical cut line at half the radius of the test apparatus 
chamber.

 SIMULATION RESULTS

WEIGHT FRACTION,  
ETHYLENE GLYCOL

VELOCITY  
(M/S)

PRESSURE DROP  
(PA)

OUTLET 
TEMPERATURE  
(K)

OUTLET DENSITY  
(KG/M)

0 1 554 370 961

0.527 1 626 373 1007

0.527 1.15 822 371 1009

0.5271 1 608 373 1010
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Using the solution for a mixture with 50 volume percent ethylene glycol in water, 
the following average values are computed: density = 1010 kg/m3, viscosity = 
9.07·10-4 Pa·s, thermal conductivity = 0.574 W/(m·K), and heat capacity = 
3486 J/(kg·K). Figure 8 shows a comparison of the temperature results obtained 
using these approximations with those using the fully coupled 
temperature-dependent properties in our test device. The similarity between these 
results is sufficient to justify the use of the approximate average values in a cooling 
jacket model with a realistic geometry. Solving the flow and heat transfer 
equations requires considerably less computational effort for the constant average 
property value case.
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Figure 8: Comparison of temperature within our test apparatus for 50 volume percent ethylene glycol in 
water at 1 m/s using: (a) temperature dependent properties, (b) approximate average properties.

Reference
1. http://www.engineeringtoolbox.com/ethylene-glycol-d_146.html

a

b
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Modeling Instructions: Engine Coolant Properties
The following step-by-step instructions guide you through the process of setting 
up a Thermodynamic System, build a geometry, and simulate the engine coolant 
physics using the Single Phase Flow, and Heat Transfer in Fluids interfaces. The 
Thermodynamic System is created from the COMSOL thermodynamic database, 
which provides all necessary thermodynamic and transport properties. 

Model Wizard

Note: These instructions are for the user interface on Windows but apply, with 
minor differences, also to Linux and macOS.

1 To start the software, double-click the COMSOL icon on the desktop. When 
the software opens, choose to use the Model Wizard to create a new COMSOL 
model, or choose Blank Model to create one manually. For this tutorial, click 
the Model Wizard button.
If COMSOL is already open, you can start the Model Wizard by choosing 

 New from the File menu and then click  Model Wizard.

The Model Wizard guides you through the first steps of setting up a model. The 
next window lets you choose the dimension of the modeling space.

2 In the Select Space Dimension window, 
click  2D Axisymmetric.
In the Select Physics tree, expand the 
nodes Fluid Flow>Nonisothermal 
Flow>Turbulent Flow and then 
double-click  Turbulent Flow, k-ε to 
add it to the Added physics interfaces list. 
You can also right-click Turbulent Flow, 
k-ε and choose  Add Physics.

3 Click  Study. In the Select Study tree, 
under General Studies, select 

 Stationary.
4 Click  Done.
16 | 



Thermodynamics

Start by adding a Thermodynamic System, which will be used to compute the 
transport and thermodynamic properties of the coolant.
1 In the Model Builder window, right-click 

 Global Definitions and choose 
Thermodynamics>  Thermodynamic 
System. This opens the Thermodynamic 
System Wizard. In the first step, select the 
phases in the system. You can choose among 
the following systems:
- Gas
- Liquid
- Vapor-liquid
- Vapor-liquid-liquid
- Liquid-liquid

2 In the Select System window, choose Vapor-liquid from the list. In this case 
a two-phase system is needed to study the phase envelope of the coolant 
mixture. When solving for the heat transfer in the test apparatus, the mixture 
will be assumed to remain in the liquid phase.

3 Click  Next in the window toolbar to proceed to the next step of the wizard. 
4 In the Select Species window, locate the Species 

list and type ethylene glycol in the Species 
filter field. While typing, the available species are 
dynamically updated in the list below.

5 Select ethylene glycol (107-21-1, C2H6O2) in 
the list of available species and click  Add 
Selected to add it to the Selected species list.

6 Perform the same steps (step 4 and 5) to add 
water, namely: 
- Type water in the Species filter field.
- Select water (7732-18-5, H2O) in the list of 

available species.
- Click  Add selected.

7 Click  Next in the window toolbar to proceed 
to the last step of the Thermodynamic System Wizard. Here you select the 
models used to compute thermodynamic and transport properties. 
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8 In the Select Thermodynamic Model window, choose UNIFAC VLE from the 
list. Then check the Advanced options check box and set Liquid volume to Ideal 
mixing. Complete the wizard by clicking  Finish in the window toolbar. 
This adds a Thermodynamic System node under  Thermodynamics in the 
Model Builder window. The default label (name) of the system is 
Vapor-Liquid System 1, indicating the phases in the system.

For more information on how to choose the thermodynamic model see Selecting 
the Right Thermodynamic Model in the Liquid & Gas Module User’s Guide.

Generate Material

When modeling a fixed composition mixture, it is convenient to use a material 
because the default behavior in physics interfaces is to use properties from the 
domain material. Ready-to-use materials can be selected from the available 
Material libraries, or generated from Thermodynamics. In this model, first 
generate a material node for the coolant, using the Thermodynamic System 
(Vapor-Liquid System 1). Later on we will use the Material library to create a 
Material for the Solid Parts of the geometry. Both these materials are then assigned 
to the relevant selections in the geometry. This allows the physics interfaces in 
these selections to access the material properties
Use Thermodynamic System (Vapor-Liquid System 1) to create a Material node 
for the properties of the mixture.
1 In the Model Builder window, under  Global Definitions 

>  Thermodynamics right-click  Vapor-Liquid System 1 (pp1) and 
choose  Generate Material. This opens the Generate Material Wizard.

2 In to the Select Phase window, choose Liquid from the list.  Click Next in 
the window toolbar.
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3 In the Select Species window, notice how 
both species are already added to the Selected 
species list.

4 In the Material composition subsection, click 
the Mass fraction button and keep the default 
composition. The composition will be 
redefined later in the generated Material.

5 Click  Next in the window toolbar.
6 In the Select Properties window, use the 

default properties.
7 Click  Next in the window toolbar.
8 In the Define Material window, add the 

material to Component 1. Also keep the 
Function type set to Thermodynamics. This 
means that material properties will directly 
use functions defined by the Vapor-Liquid 
System. It is also possible to create 
interpolation functions and use these in the material properties. 

9 Click  Finish in the window toolbar to create the material.

Global Definit ions

Load the needed parameters from a file. 
Alternatively, you could have created the 
parameters in the Parameter window 
directly.
1 In the Model Builder window, under 

 Global Definitions click 
 Parameters 1.

2 In the Settings window for Parameters, 
locate the Parameters section and click 

 Load from File.
3 Browse to the model’s Application 

Libraries folder and double-click the file 
engine_coolant_properties_parame
ters.txt.

The parameters from the txt-file are added to 
the table.
 | 19



Geometry 1

Now that we have defined our thermodynamic system and used that to generate 
a material, it is time to build the geometry for the axially symmetric engine coolant 
test apparatus (see Figure 2).

PIPE

1 In the Model Builder window, expand the 
Component 1 (comp1)>Geometry 1 node, right-click Geometry 1 and choose 
Rectangle. As an option, you can also click  Rectangle in the Geometry 
ribbon tab.

2 In the Settings window for Rectangle, locate the Size and Shape section.
3 In the Width text field, type r_p (parameter name for pipe radius).
4 In the Height text field, type l_p (parameter name for pipe length).
Both r_p and l_p are defined in the Parameters node, see section Global 
Definitions.
5 Click  Build Selected.

CHAMBER

1 In the Geometry toolbar, click  Rectangle.
2 In the Settings window for Rectangle, locate the Size and Shape section.
3 In the Width text field, type r_c (parameter name for chamber radius).
4 In the Height text field, type l_c (parameter name for chamber length).
5 Locate the Position section. In the z text field, type zpos_c (chamber position 

along the pipe).
6 Click  Build Selected.
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SOLID PART 1
1 In the Geometry toolbar, click  Rectangle.
2 In the Settings window for Rectangle, locate the 

Size and Shape section.
3 In the Width text field, type r_s1.
4 In the Height text field, type l_s1.
5 Locate the Position section. In the z text field, 

type zpos_s.
6 Click  Build Selected.

SOLID PART 2
1 In the Geometry toolbar, click  Rectangle.
2 In the Settings window for Rectangle, locate the 

Size and Shape section.
3 In the Width text field, type r_s2.
4 In the Height text field, type l_s2.
5 Locate the Position section. In the z text field, 

type zpos_s.
6 Click  Build Selected.

UNITE THE SOLID PARTS

1 In the Geometry toolbar, click  Booleans and Partitions and choose 
 Union.
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2 In the Settings 
window for Union, 
locate the Union 
section and select the 
objects r3 and r4 
only. Do so by 
clicking the Solid 
part 1 and Solid part 
2 in the Graphics 
window.

3 Clear the 
Keep interior bound
aries check box.

4 Click 
 Build Selected.

Now perform the corresponding actions to unite the pipe with the chamber.

UNITE THE PIPE AND THE CHAMBER

1 In the Geometry toolbar, click  Booleans and Partitions and choose 
 Union.

2 Select the objects r1 (pipe) and r2 (chamber) in the Graphics window.
3 In the Settings window for Union, locate the Union section and clear the 

Keep interior boundaries check box.
4 Click  Build Selected.
Continue by adding round corners to the geometry.
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FILLET

1 In the Geometry 
toolbar, click 

 Fillet.
2 On the object uni1 

(Solid parts), select 
Point 5 only. Select 
the point by clicking 
in the Graphics 
window and 
checking the point 
number in the Points 
section, Vertices to 
fillet, found in the 
Fillet Settings 
window.

3 On the object uni2 
(pipe and chamber), 
select Points 6, 7, 9, 
and 10 only.

4 In the Settings window for Fillet, locate the Radius section.
5 In the Radius text field, type 0.3[cm].
6 Click  Build All Objects.

The Geometry node in the Model Builder window should now look like this:
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Study 1:  Mixture Properties Parameterization

Now, having built the geometry for our system, compute and plot the properties 
of the glycol-water coolant as defined by the Thermodynamic System.
1 In the Model Builder window, click Study 1 .
2 In the Settings window for Study, type Study 1: Mixture properties 
parameterization in the Label text field.

3 Locate the Study Settings section. Clear the Generate default plots check box.

STEP 1: STATIONARY

Start this investigation by performing an Auxiliary sweep study, where you study 
the effect of varying mass fraction of ethylene, and varying coolant temperature.
1 In the Model Builder window, under 

Study 1: Mixture properties parameterization click Step 1: Stationary.
2 In the Settings window for Stationary, click to expand the Study Extensions 

section and select the Auxiliary sweep check box.
3 Click Add twice (button located below the table). This adds two rows to 

the table.
4 In the table, edit the two rows by selecting the below parameter names from the 

drop down menu, and enter parameter values so that the table looks like this:

PARAMETER NAME PARAMETER VALUE LIST PARAMETER UNIT

w_EG (Mass fraction, ethylene glycol) 0 0.527 1

Tc (Coolant temperature) range(273,10,473) K
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5 From the Sweep type list, choose 
All combinations.

During this first Auxiliary sweep study 
there is no need to solve for turbulent flow 
and heat transfer. Change the settings to 
omit solving for these interfaces.
1 Locate the 

Physics and Variables Selection section. 
In the Physics interface table, clear the 
Solve for check boxes for 
Turbulent Flow, k-ε (spf) and 
Heat Transfer in Fluids (ht).

2 In the Multiphysics couplings table, clear 
the Solve for check box for 
Nonisothermal Flow 1 (nitf1).
The parametric solver has now been set 
up to compute function values for pure water, a 50 volume percent mixture of 
ethylene glycol and water, and pure ethylene glycol. Furthermore, the solver 
will compute function values for a temperature range from 273 K to 473 K.

3 In the Home toolbar (or in the Settings window for Stationary), click 
 Compute.

Results

Now, inspect the mixture properties resulting from the study. Do so by creating a 
plot group and plot the results. Start with the density.

DENSITY

1 In the Home toolbar, click  Add Plot Group and choose 
 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Density in the Label field.
3 Click to expand the Title section. From the Title type list, choose None.
4 In the Density toolbar, click  Global. This adds a Global plot to the Density 

plot group.
5 In the Settings window for Global, locate the y-Axis Data section. Click Replace 

Expression  in the upper-right corner and, in the window that opens, 
either search for Densitypp1, or choose Densitypp1(...)-Density 1 
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under Model>Global definitions>Functions. Double-click the expression to 
add it to the table.

6 In the table, enter the following arguments for the function: 
Tc, pRef, w_EG, w_W. Make sure to add the arguments in this order. This is the 
order defined in the Mixture node.

7 Locate the Legends section and find the Include subsection. Clear the 
Description check box.

Note: The function named Densitypp1, can be found in the Model Builder 
window, under Global Definitions>Thermodynamics. Click the mixture density 
function, labeled Density 1, and you will find the Function name in the Settings 
window. The function was created by the Thermodynamic System and can be 
used in any physics interface. 

Now, return to the plot group to improve the plot settings.
1 In the Model Builder window, click  Density.
2 In the Settings window, locate the Plot Settings section.
3 Select the x-axis label check box and type Temperature (K).
4 Select the y-axis label check box and type Density (kg/m<sup>3</sup>).
5 Click  Plot.

The resulting plot shows the coolant density for the three compositions.
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Perform the same steps to complete the plots for viscosity, thermal conductivity, 
and heat capacity.

VISCOSITY

1 In the Home toolbar, click  Add Plot Group and choose 
 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Viscosity in the Label field.
3 In Title section, from the Title type list, choose None.
4 In the Viscosity toolbar, click  Global. This adds a Global plot to the plot 

group.
5 In the Settings window for Global, locate the y-Axis Data section. Click Replace 

Expression  in the upper-right corner and in the window that opens, 
search for Viscositypp1, or choose Viscositypp1(...)-Viscosity 1 
under Model>Global definitions>Functions. Double-click the expression to 
add it to the table.
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6 In the table, enter the following arguments for the function:

7 Locate the Legends section and find the Include subsection. Clear the 
Description check box.

Now, return to the plot group to fine tune the plot settings.
1 In the Model Builder window, click  Viscosity.
2 In the Settings window, locate the Plot Settings section.
3 Select the x-axis label check box and type Temperature (K).
4 Select the y-axis label check box and type Viscosity (Pa\cdot s).
5 Click  Plot.

The resulting plot shows the coolant viscosity for the three compositions.

EXPRESSION UNIT DESCRIPTION

Viscositypp1(Tc,pRef,w_EG,w_W)
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THERMAL CONDUCTIVITY

1 In the Home toolbar, click  Add Plot Group and choose 
 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Thermal Conductivity in 
the Label field.

3 In the Title section, from the Title type list, choose None.
4 In the Thermal Conductivity toolbar, click  Global. 
5 In the Settings window for Global, locate the y-Axis Data section. Click Replace 

Expression  in the upper-right corner and, in the window that opens, 
either search for ThermalConductivitypp1, or choose 
ThermalConductivitypp1(...)-Thermal conductivity 1 under 
Model>Global definitions>Functions. Double-click the expression to add it to 
the table.

6 In the table, enter the following arguments for the function:

7 Locate the Legends section and find the Include subsection. Clear the 
Description check box.

Now, return to the plot group to perfect the plot settings.
1 In the Model Builder window, click  Thermal Conductivity.
2 In the Settings window, locate the Plot Settings section.
3 Select the x-axis label check box and type Temperature (K).
4 Select the y-axis label check box and type Thermal conductivity (W/
(m\cdot K)).

5 Locate the Legend section. From the Position list, choose Middle right.
6 Click  Plot.

The resulting plot shows the coolant thermal conductivity for the three 
compositions.

EXPRESSION UNIT DESCRIPTION

ThermalConductivitypp1(Tc,pRef,w_EG,w_W)
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HEAT CAPACITY

1 In the Home toolbar, click  Add Plot Group and choose 
 1D Plot Group.

2 In the Settings window for 1D Plot Group, type Heat Capacity in the Label 
field.

3 In the Title section, from the Title type list, choose None.
4 In the Heat Capacity toolbar, click  Global. 
5 In the Settings window for Global, locate the y-Axis Data section. Click Replace 

Expression  in the upper-right corner and, in the window that opens, 
either search for HeatCapacity, or choose HeatCapacityCppp1(...)-Heat 
capacity 1 under Model>Global definitions>Functions. Double-click the 
expression to add it to the table.

6 In the table, enter the following arguments for the function:

EXPRESSION UNIT DESCRIPTION

HeatCapacityCppp1(Tc,pRef,w_EG,w_W)
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7 Locate the Legends section and find the Include subsection. Clear the 
Description check box.

Now, return to the plot group to better the plot settings.
1 In the Model Builder window, click  Heat Capacity.
2 In the Settings window, locate the Plot Settings section.
3 Select the x-axis label check box and type Temperature (K).
4 Select the y-axis label check box and type Heat capacity (J/(kg\cdot K)).
5 Locate the Legend section. From the Position list, choose Upper left.
6 Click  Plot.

The resulting plot is seen in Figure 3.

Equil ibrium Calculation

Now, use the thermodynamic system to define an equilibrium function. This will 
be used to visualize the phase envelope of the coolant mixture.
1 In the Model Builder window, under 

 Global Definitions>  Thermodynamics right-click 
 Vapor-Liquid System 1 (pp1) and choose  Equilibrium Calculation.

1 Go to the Select Species window.
2 Click  Add All.
3 Click  Next in the window toolbar.
4 Go to the Equilibrium Specifications window.
5 From the Amount base unit list, choose mol.
Specify the equilibrium conditions. It is possible 
to create different equilibrium diagrams such as 
T-x, h-x, P-x, x-y, and so on using two 
equilibrium conditions. These available 
conditions are: Temperature, Pressure, Phase 
fraction, Enthalpy, Entropy, Energy, Density and 
Volume.
6 Find the Equilibrium conditions subsection. 

From the First condition list, choose 
Pressure.

7 From the Second condition list, choose 
Phase fraction.
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8 Click  Next in the window toolbar.
9 Go to the 

Equilibrium Function Overview 
window. The functions to be 
created and their arguments are 
now displayed. Note especially 
Flash1_1_Temperature. This 
equilibrium function will be used 
to plot the phase envelope

10Click  Finish in the window 
toolbar. This creates an 
Equilibrium Calculation node in 
the Model Builder window.

You can now create an  Analytic 
function to plot the phase envelope.

Analytic Function

Create an Analytic function from the equilibrium function just defined. Analytic 
functions are convenient since they do not require the actual argument names in 
an expression when writing the function. Use the Analytic function to change the 
composition arguments from moles to mole fractions.
1 In the Home toolbar, click  Functions and choose  Analytic in the 

Global section.
2 In the Settings window for Analytic, type 
Phase envelope in the Label text field.

3 In the Function name text field, type T_x_y.
4 Locate the Definition section.

- In the Expression text field, type 
Flash1_1_Temperature(p,n,w_EG,w_W). 
You may press Ctrl + space after having 
written a few characters to get suggestions.

- In the Arguments text field, type p, n, 
w_EG, w_W.
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Remember to use the same order of the arguments as defined in the Equilibrium 
Calculation node.
5 Locate the Units section.

- In the Function text field, type K.
- In the Arguments text field, type Pa,1,mol/mol,mol/mol.

Note: The Expression Flash1_1_Temperature and what arguments to use can 
be found in the Model Builder window, under 
Global Definitions>Thermodynamics>Vapor-Liquid System 1 (pp1)>Mixture. 
Under Mixture, click Equilibrium Calculation. In the Settings window, locate the 
Functions subsection, as well as the Arguments subsection, both in the 
Definition section.

Add Study

Add a Study to compute the phase envelope for the mixture, using the defined 
analytic function.
1 In the Home toolbar, click  Add Study to open the Add Study window.
2 Go to the Add Study window.
3 Find the Studies subsection and select  Stationary under General in the 

Select Study tree.
4 Click  Add Study. This adds a Study node in the Model Builder window.
5 In the Home toolbar, click  Add Study to close the Add Study window.

Study 2:  Phase Envelope Parameterization

Add settings to perform an Auxiliary sweep study, where we vary the mass fraction 
of ethylene glycol, phase fraction, and coolant pressure.
1 In the Settings window for Stationary, locate the Study Extensions section.
2 Select the Auxiliary sweep check box.
3 Click  Add three times. This will add three rows to the table.
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4 In the table, enter the following settings (use the associated drop down list):

5 From the Sweep type list, choose All combinations.
The parametric solver has now been set up to compute function values for the 
entire range of compositions for the binary mixture, only vapor and only liquid, as 
well as two pressure levels.
6 Locate the Physics and Variables Selection section. In the Physics interface 

table, clear the Solve for check boxes for Turbulent Flow, k-ε (spf) and 
Heat Transfer in Fluids (ht).

7 In the Multiphysics couplings table, clear the Solve for check box for 
Nonisothermal Flow 1 (nitf1).

Go back to the Study node.
1 In the Model Builder window, click  Study 2.
2 In the Settings window for Study, type Study 2: Phase envelope 
parameterization in the Label text field.

3 Locate the Study Settings section. Clear the Generate default plots check box.
4 In the Home toolbar, click  Compute.

The function for the equilibrium values has now been computed for the specified 
parameters. You can plot the phase envelope, as a function of the mole fraction of 
ethylene glycol, for the two pressures.

Results

Plot the phase envelope, for the two pressures used, as a function of the mole 
fraction of ethylene glycol.

PHASE ENVELOPE

1 In the Home toolbar, click  Add Plot Group and choose 
 1D Plot Group.

2 In the Settings window for 1D Plot Group, locate the Data section.

PARAMETER NAME PARAMETER VALUE LIST PARAMETER UNIT

w_EG (Mass fraction, ethylene 
glycol)

range(0,0.01,1)

n (Phase fraction) 0 1

pRef (Coolant pressure) 1[atm] 2[atm] Pa
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3 From the Dataset list, choose Study 2: Phase envelope parameterization/
Solution 2 (sol2).

4 Locate the Title section. From the Title type list, choose None.
5 Locate the Plot Settings section. Select the x-axis label check box.
6 In the associated text field, type Mole fraction ethylene glycol.
7 Select the y-axis label check box.
8 In the associated text field, type Temperature (K).

GLOBAL 1
1 In the 1D Plot Group 5 toolbar, click  Global.
2 In the Label field, enter Phase envelope
3 In the Settings window for Global, locate the y-Axis Data section.
4 In the table, enter the following settings:

5 Locate the x-Axis Data section. From the Axis source data list, choose w_EG.
6 In the Phase Envelope toolbar, click  Plot. This generates Figure 4. The 

figure shows that the phase envelope is moved to higher temperatures when the 
pressure increases.

To position the legend and rename the plot group use the following steps.
1 In the Model Builder window, click Phase Envelope.
2 In the Settings window for Phase Envelope, locate the Legend section.
3 From the Position list, choose Upper left.
4 Click OK.

EXPRESSION UNIT DESCRIPTION

T_x_y(pRef, n, w_EG, w_W)
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Material  for Fluid Domain

Apply the material to the fluid domain. 
Also, use the defined parameters to 
specify the mixture composition. This 
makes it easy to vary the composition. 

LIQUID: ETHYLENE GLYCOL-WATER 1 

(PP1MAT1)
1 In the Model Builder window, expand 

the Component 1 
(comp1)>  Materials node, then 
click the created material  Liquid: 
ethylene glycol-water 1 (pp1mat1).

2 Select Domain 1 only. Select 2 in the 
Geometric Entity Selection section, 
click the minus sign.

3 Locate the Material Contents section.
4 Find the Local properties subsection. 

In the table, enter the following 
settings:

Now apply boundary conditions for turbulent flow and heat transfer.

Turbulent Flow, k-ε (spf)

1 In the Model Builder window, under  Component 1 (comp1) click 
 Turbulent Flow, k-ε (spf).

2 Select Domain 1 only. Do so by removing 2 from the Domain Selection section, 
this can also be achieved by clicking in the Graphics window. Fluid flow will now 
be solved for Domain 1 only.

Add the inlet and outlet conditions for the fluid flow.

NAME EXPRESSION UNIT DESCRIPTION PROPERTY 
GROUP

xw1 w_EG Mass fraction, ethylene glycol Basic

xw2 w_W Mass fraction, water Basic
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INLET 1
1 In the Physics toolbar, click  Boundaries and choose  Inlet.
2 Select Boundary 2, the bottommost boundary.
3 In the Settings window for Inlet, locate the Velocity section.
4 In the U0 text field, type Vel, the inlet velocity parameter.

OUTLET 1
1 In the Physics toolbar, click  Boundaries and choose  Outlet.
2 Select Boundary 11, the boundary at the top of the fluid flow domain.

Heat Transfer in Fluids (ht)

1 In the Model Builder window, under  Component 1 (comp1) click 
 Heat Transfer in Fluids (ht).

INFLOW 1
1 In the Physics toolbar, click  Boundaries and choose  Inflow.
2 Select Boundary 2 only, the bottommost boundary.
3 In the Settings window for Inflow, locate the Upstream Properties section.
4 In the Tustr text field, type Tc.
5 Select the Specify upstream absolute pressure check box.
6 In the pustr text field, type pRef.

OUTFLOW 1
1 In the Physics toolbar, click  Boundaries and choose Outflow.
2 Select Boundary 11 only, the boundary at the top of the fluid flow domain.

HEAT FLUX 1
1 In the Physics toolbar, click  Boundaries and choose  Heat Flux.
2 Select Boundary 18, the right most boundary adjacent to the fluid flow domain.
3 In the Settings window for Heat Flux, locate the Heat Flux section.
4 Select Heat rate as the Flux type.
5 In the P0 text field, type P0.
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SOLID 1
1 In the Physics toolbar, click  Domains and choose Solid.
2 Select Domain 2 only.

Add Material

Add material properties for the solid steel part from Materials. Do so by using a 
built-in material.
1 In the Home toolbar, click  Add Material to open the Add Material 

window.
2 Go to the Add Material window.
3 In the tree, select Built-in>Structural steel.
4 Click Add to Component in the window toolbar.
5 In the Home toolbar, click  Add Material to close the Add Material 

window.
6 In the Settings window, select Domain 2 only. Do so by clicking on the Solid 

part 2 in the Graphics window, and confirming the Selection in the Geometric 
Entity Selection section.

The Materials node; the Turbulent Flow, k-ε node; and the Heat Transfer in 
Fluids node should now have the following child nodes in the Model Builder 
window:
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Add Study

Now, add a Stationary study to solve for the fluid flow and heat transfer in the test 
apparatus, using pure water as the coolant.
You will use two stationary study steps. The first step solves for the fluid flow only. 
This study step serves as initial conditions for the second step, which in turn solves 
for both fluid flow and heat transfer.
1 In the Home toolbar, click  Add Study to open the Add Study window.
2 Go to the Add Study window.
3 Find the Studies subsection. In the Select Study tree, select 

General Studies>  Stationary.
4 Find the Physics interfaces in study subsection. In the table, clear the Solve 

check box for Heat Transfer in Fluids (ht).
5 Click  Add Study in the window toolbar.

Study 3:  Water

1 In the Settings window for Stationary, locate the Study Extensions section.
2 Select the Auxiliary sweep check box.
3 Click  Add.
4 In the table, enter the following settings:

5 Click Study 3 in the Model Builder window, and in the Settings window for 
Study, type Study 3: Water in the Label text field.

STATIONARY 2
1 In the Study toolbar, click  Study Steps and choose 

Stationary>  Stationary.
2 In the Settings window for Stationary, click to expand the Study Extensions 

section.
3 Select the Auxiliary sweep check box.
4 Click  Add.

PARAMETER NAME PARAMETER VALUE LIST PARAMETER UNIT

w_EG (Mass fraction, ethylene glycol) 0
 | 39



5 In the table, enter the following settings:

SOLUTION 3 (SOL3)
1 In the Study toolbar, click  Show Default Solver.
Study step 2 uses the solution for the flow field (in Step 1) as initial conditions. In 
this case Anderson acceleration can be enabled to reduce the simulation time.
2 In the Model Builder window, expand the 

 Study 3: Water>  Solver Configurations>
 Solution 3 (sol3)>  Stationary Solver 2 

node, then click  Segregated 1.
3 In the Settings window for Segregated, locate the 

General section.
4 From the Stabilization and acceleration list, 

choose Anderson acceleration.
5 In the Study toolbar, click  Compute.

When the solver finishes the plot group 
Velocity, 3D (spf) displays the flow field in the 
apparatus using a revolved dataset.

Results

Begin by deleting some superfluous plot groups.
1 In the Model Builder window, under  Results, Ctrl-click to select

- Velocity (spf)
- Pressure (spf)
- Wall Resolution (spf)
- Temperature, 3D (ht)
- Isothermal Contours (ht)

2 Right-click and choose Delete.
3 Click Yes.

Create a 2D plot group for the temperature.

PARAMETER NAME PARAMETER VALUE LIST PARAMETER UNIT

w_EG (Mass fraction, ethylene glycol) 0
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2D PLOT GROUP 10
1 In the Home toolbar, click  Add Plot Group and choose 

 2D Plot Group.
2 Type Temperature in the Label text field.
3 In the Settings window for 2D Plot Group, locate the Data section.
4 From the Dataset list, choose Study 3: Water/Solution 3 (sol3).
5 Click to expand the Title section. From the Title type list, choose Manual.
6 In the Title text area, type Temperature (K).

SURFACE 1
1 In the Temperature toolbar, click  Surface.
2 In the Settings window for Surface, locate the Expression section.
3 In the Expression text field, type T.
4 In the Temperature toolbar, click  Plot.
5 Click to expand the Range section. Select the Manual color range check box.
6 In the Maximum text field, type 400.
7 In the Temperature toolbar, click  Plot.
8 Click the  Zoom Extents button in the Graphics toolbar.

This completes the setup of Figure 6a.

Add Study

Add a new Study to solve for the fluid flow and heat transfer in the test apparatus 
when using a coolant mixture composed of equal volumes of ethylene glycol and 
water. Use two study steps: One step using the same inlet velocity as for the pure 
water case and another study step where the flow rate of the ethylene/water 
mixture is increased by 15%.
1 In the Home toolbar, click  Add Study to open the Add Study window.
2 Go to the Add Study window and find the Studies subsection. In the Studies 

tree, select  General Studies>  Stationary.
3 Click Add Study in the window toolbar. If you wish to close the Add Study 

window, go to the Home toolbar and click  Add Study.
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Study 4:  Glycol and Water

Enter the settings for the added study. As mentioned, we will use two study steps, 
both stationary. The output from these studies will result in Figure 6b and c.

STEP 1: STATIONARY

1 In the Settings window for  Step 1: Stationary, locate the Study Extensions 
section.

2 Select the Auxiliary sweep check box.
3 Click  Add twice to add two rows to the table.
4 In the table, enter the following settings:

Add the second step by duplicating the first one.

STEP 2: STATIONARY

1 Right-click Study 4>Step 1: Stationary and choose Duplicate.
2 In the Settings window for Stationary, locate the Study Extensions section.
3 In the table, enter the following settings:

Now enter the needed settings for the two steps.

STEP 1: STATIONARY

1 In the Model Builder window, click  Step 1: Stationary.
2 In the Settings window for Stationary, click to expand the 

Values of Dependent Variables section.
3 Find the Initial values of variables solved for subsection. From the Settings list, 

choose User controlled.
4 From the Method list, choose Solution.
5 From the Study list, choose Study 3: Water, Stationary 2.

PARAMETER NAME PARAMETER VALUE LIST PARAMETER UNIT

w_EG (Mass fraction, ethylene glycol) 0.527

Vel (Pipe inlet velocity) 1 m/s

PARAMETER NAME PARAMETER VALUE LIST PARAMETER UNIT

w_EG (Mass fraction, ethylene glycol) 0.527

Vel (Pipe inlet velocity) 1.15 m/s
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STEP 2: STATIONARY

1 In the Study toolbar, click  Show Default Solver.
Apply Anderson acceleration also for the cases using ethylene glycol. Note that the 
previous solution, using water as coolant, was used for the initial conditions.
2 In the Model Builder window, expand the 

 Study 4>  Solver Configurations>  Solution 5 (sol5)>  Stationary 
Solver 1 node, then click  Segregated 1.

3 In the Settings window for Segregated, locate the General section.
4 From the Stabilization and acceleration list, choose Anderson acceleration.
5 In the Model Builder window, collapse the Stationary Solver 1 node.
Now add the same settings to the solver for step 2.
6 In the Model Builder window, expand the 

 Study 4>  Solver Configurations>  Solution 5 (sol5)>  Stationary 
Solver 2 node, then click  Segregated 1.

7 In the Settings window for Segregated, locate the General section.
8 From the Stabilization and acceleration list, choose Anderson acceleration.
9 In the Model Builder window, click  Study 4.
10In the Settings window for Study, type Study 4: Glycol and Water in the 

Label text field.
11Locate the Study Settings section. Clear the Generate default plots check box.
12In the Study toolbar, click  Compute.
13In the Model Builder window, under 

 Study 4: Glycol and Water>  Solver Configurations>  Solution 5 (sol
5) click  Solution Store 2 (sol6).

14In the Settings window for Solution Store, type Vel = 1.0 m/s in the Label 
text field.

15In the Model Builder window, click  Solution 5 (sol5).
16In the Settings window for Solution, type Vel = 1.15 m/s in the Label text 

field.

Results

Let’s look at the results from the two study steps just added. Plot the temperature 
for the glycol/water mixture to reproduce the plots in Figure 6.
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TEMPERATURE PLOT

1 In the Model Builder window, under  Results click  Temperature.
2 In the Settings window for 2D Plot Group, locate the Data section.
3 From the Dataset list, choose Study 4: Glycol and Water /Vel = 1.0 m/

s (sol6).
4 In the Temperature toolbar, click  Plot. This generates Figure 6b. Note that 

the temperature in the apparatus in general is higher than for the case of pure 
water, mainly due to the lower heat capacity of the glycol/water mixture.

5 From the Dataset list, choose Study 4: Glycol and Water /Vel = 1.15 m/
s (sol5).

6 In the Temperature toolbar, click  Plot. This generates Figure 6c. Note now 
that the increased flow rate reduces the temperature to levels close to the water 
case.

Next, evaluate the resulting mixture properties within the apparatus. Create three 
cut line datasets to evaluate the heat capacity throughout the chamber section of 
the apparatus.

Cut Line 2D 1
1 In the Results toolbar, click  Cut Line 2D.
2 In the Settings window for Cut Line 2D, locate the Line Data section.
3 In row Point 1, set r to r_c*0.5.
4 In row Point 2, set r to r_c*0.5.
5 In row Point 2, set z to 1.
6 Locate the Data section. From the Dataset list, choose Study 3: Water/

Solution 3 (sol3).

Create two more datasets, one for each solution.

Cut Line 2D 2
1 Right-click Cut Line 2D 1 and choose Duplicate.
2 In the Settings window for Cut Line 2D, locate the Data section.
3 From the Dataset list, choose Study 4: Glycol and Water /Vel = 1.0 m/

s (sol6).

Cut Line 2D 3
1 Right-click Cut Line 2D 2 and choose Duplicate.
2 In the Settings window for Cut Line 2D, locate the Data section.
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3 From the Dataset list, choose Study 4: Glycol and Water /Vel = 1.15 m/
s (sol5).

Now use the three datasets to create Figure 7.

HEAT CAPACITY, CHAMBER CUT LINE PLOT

In the Results toolbar, click  1D Plot Group.

Line Graph 1
1 In the 1D Plot Group 11 toolbar, click  Line Graph.
2 In the Settings window for Line Graph, locate the Data section. From the 

Dataset list, choose Cut Line 2D 1.
3 Locate the y-Axis Data section. In the Expression text field, type ht.Cp.
4 Click to expand the Legends section. Select the Show legends check box.
5 From the Legends list, choose Manual.
6 In the table, enter the following settings:

7 In the 1D Plot Group 11 toolbar, click  Plot.

Line Graph 2
1 Right-click Line Graph 1 and choose Duplicate.
2 In the Settings window for Line Graph, locate the Data section. From the 

Dataset list, choose Cut Line 2D 2.
3 Locate the Legends section. In the table, enter the following settings:

4 In the 1D Plot Group 11 toolbar, click  Plot.

Line Graph 3
1 Right-click Line Graph 2 and choose Duplicate.
2 In the Settings window for Line Graph, locate the Data section. From the 

Dataset list, choose Cut Line 2D 3.

LEGENDS

Water

LEGENDS

Glycol/Water
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3 Locate the Legends section. In the table, enter the following settings:

4 In the 1D Plot Group 11 toolbar, click  Plot, to visualize the heat capacity 
along the vertical cut line for the three cases solved (see Figure 7).

Rename the plot group and improve the plot settings.
1 In the Model Builder window, click  1D Plot Group 11.
2 In the Settings window for 1D Plot Group, locate the Legend section.
3 From the Position list, choose Middle right.
4 Locate the Title section. From the Title type list, choose None.
5 Right-click 1D Plot Group 11 and choose Rename.
6 In the Rename 1D Plot Group dialog box, type Heat Capacity, Chamber 
Cut Line in the New label text field.

7 Click OK.

Evaluate

Compute the average mixture property values. These will be used to compute the 
flow and heat transfer in the test apparatus, visualized in Figure 8.

SURFACE AVERAGE 1
1 In the Results toolbar, click  More Derived Values and choose 

Average>  Surface Average.
2 In the Settings window for Surface Average, locate the Data section.
3 From the Dataset list, choose Study 4: Glycol and Water /Vel = 1.0 m/

s (sol6).
4 Select Domain 1 only. Do this by pressing Domain 1 in the Graphics window, 

and verifying the selection in the Selection section in the Surface Average 
Settings window.

5 Locate the Expressions section. In the table, enter the following settings:

LEGENDS

Glycol/Water, Vel = 1.15 m/s

EXPRESSION UNIT DESCRIPTION

ht.rho kg/m^3 Density

ht.Cp J/(kg*K) Heat capacity at constant pressure
46 | 



6 Click  Evaluate in the toolbar of the Settings window.

The computed averages are found in Table 1 , added under the Tables  
node under  Results in the Model Builder. Now store the average property 
values as parameters.

PARAMETERS 1
1 In the Model Builder window, under  Global Definitions click 

 Parameters 1.
2 In the Settings window for Parameters, locate the Parameters section.
3 In the table, add the following rows:

Finally, compute the flow and heat transfer in the test apparatus using the averaged 
mixture properties. First apply the mixture parameters.

Heat Transfer in Fluids (ht)

Finally compute the flow and heat transfer in the test apparatus using the average 
values for the mixture properties.

ht.krr W/(m*K) Thermal conductivity, rr component

spf.mu Pa*s Dynamic viscosity

NAME EXPRESSION VALUE DESCRIPTION

rhoC 1010[kg/m^3] 1010 kg/m³ Average constant density

CpC 3487[J/kg/K] 3486 J/(kg·K) Average constant heat capacity

kC 0.574[W/m/K] 0.574 W/(m·K) Average constant conductivity

muC 9.04e-4[Pa*s] 9.07E-4 Pa·s Average constant viscosity

EXPRESSION UNIT DESCRIPTION
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1 In the Model Builder window, under 
 Component 1 (comp1)>  Heat Transfer in Fl

uids (ht) click  Fluid 1.
2 In the Settings window for Fluid, locate the 

Heat Conduction, Fluid section.
3 From the k list, choose User defined. In the 

associated text field, type kC.
4 Locate the Thermodynamics, Fluid section. From the 

Fluid type list, choose Gas/Liquid.
5 From the ρ list, choose User defined. In the 

associated text field, type rhoC.
6 From the Cp list, choose User defined. In the 

associated text field, type CpC.

Turbulent Flow, k-ε (spf)

FLUID PROPERTIES 1
1 In the Model Builder window, under 

 Component 1 (comp1)>  Turbulent Flow, k-ε (spf) click 
 Fluid Properties 1.

2 In the Settings window for Fluid Properties, locate the Fluid Properties section.
3 From the μ list, choose User defined. In the associated text field, type muC.

Add Study

1 In the Home toolbar, click  Add Study to open the Add Study window.
2 Go to the Add Study window.
3 Find the Studies subsection. In the Studies tree, select 

 General Studies>  Stationary.
4 Click Add Study in the window toolbar.
5 In the Home toolbar, click  Add Study to close the Add Study window.
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Study 5:  Glycol and Water,  Constant Properties

Add the settings for the final Study in this model. Use the solution from Study 3 
as initial values.

STEP 1: STATIONARY

1 In the Settings window for Stationary, locate the Values of Dependent Variables 
section.

2 Find the Initial values of variables solved for subsection. From the Settings list, 
choose User controlled.

3 From the Method list, choose Solution.
4 From the Study list, choose Study 3: Water, Stationary 2.
5 In the Study Extensions section, enable Auxiliary sweep, add Vel and enter 1.0 

as a single entry in Parameter value list.
6 In the Model Builder window, click Study 5.
7 In the Settings window for Study, type Study 5: Glycol and Water, 
Constant Properties in the Label text field.

8 Locate the Study Settings section. Clear the Generate default plots check box.
9 In the Home toolbar, click  Compute.

Results

Plot the temperature for the case with average values for the mixture properties.

TEMPERATURE

1 In the Model Builder window click  Results>  Temperature.
2 In the Settings window for 2D Plot Group, locate the Data section.
3 From the Dataset list, choose 

Study 5: Glycol and Water, Constant Properties /Solution 7 (sol7).
4 In the Temperature toolbar, click  Plot.

You can now compute the outlet temperature, the average pressure drop, and the 
average outlet density for the four simulations performed:
• Water
• Glycol and Water, Vel = 1.0 m/s
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• Glycol and Water, Vel = 1.15 m/s
• Glycol and Water, Constant Properties

First add a Point Evaluation node to study the outlet temperature. 

POINT EVALUATION: OUTLET TEMPERATURE

1 In the Results toolbar, click  Point Evaluation.
2 Select Point 6, the uppermost point in the solid domain on the symmetry line. 

Do so by clicking in the Graphics window and verifying the selection in the 
Selection section in the Settings window for Point Evaluation.

3 Locate the Expressions section and enter the following settings in the table:

4 Locate the Data section. From the Dataset list, 
choose Study 3: Water/Solution 3 (sol3).

5 Click  Evaluate at the top of the Settings 
window.

6 From the Dataset list, choose 
Study 4: Glycol and Water /Vel = 1.0 m/
s (sol6).

7 Click next to  Evaluate, then choose 
New Table to add the evaluation to a new table.

8 From the Dataset list, choose 
Study 4: Glycol and Water /Vel = 1.15 m/
s (sol5).

9 Click next to  Evaluate, then choose 
New Table.

10From the Dataset list, choose 
Study 5: Glycol and Water, Constant Properties 
/Solution 7 (sol7).

11Click next to  Evaluate, then choose New Table.

In this manner, four tables (Table 2–5), containing the outlet temperature, have 
been added under Tables , one for each of the coolant simulations performed.
Next, add a Line Average node to compute the average pressure at the inlet. Since 
a zero reference pressure is applied at the outlet, the inlet pressure represents the 
pressure drop over the system. 

EXPRESSION UNIT DESCRIPTION

T K
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LINE AVERAGE: PRESSURE DROP

1 In the Results toolbar, click  More Derived Values and choose 
Average>  Line Average.

2 Select Boundary 2 at the bottom of the geometry, corresponding to the inlet.
3 In the Settings window for Line Average, locate the Expressions section.
4 In the table, enter the following settings:

5 Locate the Data section. From the Dataset list, choose Study 3: Water/
Solution 3 (sol3).

6 Click  Evaluate (Table 2 - Point Evaluation 1).
In the same manner, perform the same steps to derive the pressure drop for the 
remaining flow solutions. Add the pressure drop to the table containing the outlet 
temperature for the same case.
7 From the Dataset list, choose Study 4: Glycol and Water /Vel = 1.0 m/

s (sol6).
8 Click next to  Evaluate, then choose Table 3 - Point Evaluation 1. Click 

 Evaluate.
9 From the Dataset list, choose Study 4: Glycol and Water /Vel = 1.15 m/

s (sol5).
10Click next to  Evaluate, then choose Table 4 - Point Evaluation 1. Click 

 Evaluate.
11From the Dataset list, choose 

Study 5: Glycol and Water, Constant Properties /Solution 7 (sol7).
12Click next to  Evaluate, then choose Table 5 - Point Evaluation 1. Click 

 Evaluate.

Finally, add another Line Average node to compute the average density at the 
outlet. 

LINE AVERAGE: OUTLET DENSITY

1 In the Results toolbar, click  More Derived Values and choose 
Average>  Line Average.

2 Select Boundary 11, the outlet boundary.
3 In the Settings window for Line Average, locate the Expressions section.

EXPRESSION UNIT DESCRIPTION

p Pa
 | 51



4 In the table, enter the following settings (the density defined by the 
Heat Transfer in Fluids (ht)  interface):

5 Locate the Data section. From the Dataset list, choose Study 3: Water/
Solution 3 (sol3).

6 Click next to  Evaluate, then choose Table 2 - Point Evaluation 1. Click 
 Evaluate.

7 From the Dataset list, choose Study 4: Glycol and Water /Vel = 1.0 m/
s (sol6).

8 Click next to  Evaluate, then choose Table 3 - Point Evaluation 1. Click 
 Evaluate.

9 From the Dataset list, choose Study 4: Glycol and Water /Vel = 1.15 m/
s (sol5).

10Click next to  Evaluate, then choose Table 4 - Point Evaluation 1. Click 
 Evaluate.

11From the Dataset list, choose 
Study 5: Glycol and Water, Constant Properties /Solution 7 (sol7).

12Click next to  Evaluate, then choose Table 5 - Point Evaluation 1. Click 
 Evaluate.

EXPRESSION UNIT DESCRIPTION

ht.rho kg/m^3
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Heat Pipe with Accurate Liquid and Gas Properties

Heat pipes are designed to transfer heat efficiently through vaporization, mass 
transfer, and condensation of a working fluid. They are found in a wide variety of 
applications where thermal control is of importance, with cooling of electronics 
being a prominent example.
Inside a heat pipe, the temperature difference between the hot and cold side along 
with the temperature dependence of the vapor pressure, induce a pressure 
difference across the vapor chamber. The pressure difference, in turn, drives the 
vapor from the hot to the cold side. The vaporization acts as a heat sink at the 
vapor–wick interface at the hot side, and conversely, the condensation as a heat 
source, at the cold side. This model demonstrates how the laminar flow in the 
vapor chamber of the heat pipe can be coupled to the liquid phase transport 
through the porous wick. It also shows how thermodynamic properties of water 
can be obtained from the database in the Liquid & Gas Properties Module. The 
importance of vapor transport is compared to the conductive heat transfer in the 
pipe wall. The former dominates the latter by several orders of magnitude.

Model Definition
Heat pipes exist in variety of different shapes, with tubular ones probably being 
the most common kind. Here we will look at an axisymmetric model of a copper 
tube with a porous copper wick and a vapor chamber. The heat pipe has a contact 
surface at the bottom, which is to be connected to the source of the heat to be 
removed. At the top of the pipe a similar contact surface for a heat sink is used. 
The latter often corresponds to a finned metal structure which can easily be cooled 
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by a fan. The geometry used including the different parts is visualized in the figure 
below.

Overview of the heat pipe geometry.

Before setting up the model, we will investigate under what conditions our 
assumption of a saturated wick holds.
For heat pipes operating near ambient conditions, the capillary pressure, Δpc, is 
usually the limiting factor (Ref. 2):

 (1)

Here σ is the surface tension and rc is the capillary radius. At the capillary limit, 
this pressure equals the pressure needed to drive the vapor, the static pressure due 
to gravity, and the pressure needed to drive liquid through the wick in the manner 
of:

 (2)

For most applications, we can neglect all but the liquid term, which can be 
obtained from Darcy’s law:

Heat sink Contact Surface

Heat Source Contact Surface

Vapor Cavity

Porous Copper Wick

Solid Copper Tube Wall

pcΔ 2 σ
rc
----=

pcΔ Δpv Δpg Δpl+ +=
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 (3)

where μl is the dynamic viscosity of the liquid, Leff is the effective length of the 
heat pipe, K is the permeability of the wick, Aw is the cross-sectional area of the 
wick, and  is the volumetric flow rate. The latter is governed by the rate of 
evaporation:

 (4)

where,  is the heat transfer rate, ρ is the density of the liquid, ΔHvap is the latent 
heat of vaporization (with dimensionality of energy per mass). Inserting 
Equation 2-4 into Equation 1, and neglecting Δpv and Δpg yields:

 (5)

Evaluating Equation 5 with K =1·10-9 m2, Aw =1·10-4 m2, ΔHvap = 2.5·106J/kg, 
ρ = 1·103 kg/m3, σ = 7·10-2 N/m, μ = 1·10-3 Pa·s, L = 0.15 m, and 
r = 3.1·10-5 m, we obtain a value of 7.5 kW. In the model, a modest heat transfer 
rate of 30 W will be used, thus far from the capillary limit. As a comparison a CPU 
of a typical consumer PC produces on the order of 10–100 W.

PHYSICS SETUP

A Laminar Flow interface is used to solve for the flow fluid in the vapor cavity. It is 
subjected to single boundary condition, apart from the axial symmetry line. The 
pressure is prescribed to equal the saturated vapor pressure at the cavity–wick 
interface.

 (6)

This implies that the water and vapor phase are assumed to be in equilibrium at 
this position. The vapor pressure increases with temperature, which is what drives 
the vapor from the high temperature region to the low temperature region. For 
the liquid flow in the porous wick, a Brinkman Equations interface is used. The 
velocity in the wick at cavity–wick interface is computed from the vapor flow rate 
on the cavity side

 (7)

The pressure level is fixed using a pressure point constraint on the solid wall in the 
middle of the geometry.
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For heat transfer in all parts of the geometry, the tube wall, the wick, and the vapor 
cavity, a Heat Transfer in Porous Media interface is used. It includes domain features for 
each domain type.

MATERIAL PROPERTIES

Material properties are created using the Thermodynamics node. A vapor system 
using the ideal gas law is setup for the vapor phase, while a liquid system using 
IAPWS models (Ref. 3) is created for the liquid phase in the wick. To describe the 
saturation pressure a vapor pressure function is created for the liquid system. In 
order to easily apply properties in the model, two materials are created using the 
Generate Material option available for thermodynamic systems. Copper from the 
material library is used for the properties in the tube wall.

Results and Discussion
As a first step, analyze the temperature when conduction is the only means of 
energy transport in the pipe. This corresponds to using a dry wick, with no liquid 
water, and negligible natural convection in the vapor. The resulting temperature 
is seen in Figure 9 below.

Figure 9: Temperature of heat pipe with dry wick.
56 | 



We note that the temperature at the heat source is almost 100°C higher than at 
the heat sink. In an application where temperature sensitive parts are present 
(electronics, plastics, and so on) such a high temperature would be detrimental.
In the second simulation, the wick is assumed to be saturated with liquid water, 
corresponding to a heat pipe running at its design point. The resulting 
temperature profile, seen in Figure 10, looks very different.

Figure 10: Temperature of heat pipe with saturated wick.

The predicted temperature difference between heat sink and heat source is now 
less than 2°C. And the surface of the heat pipe outside of the contact areas is 
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essentially isothermal. In Figure 11, the computed velocity fields, in both fluids, 
and the temperature throughout the geometry, are plotted next to each other.

Figure 11: Fluid velocities—lg(|u| / m·s-1) and temperature in the heat pipe running at the design 
point.

The heat transfer process can be decomposed into different contributions, by 
computing line integrals across the cavity, wick and casing at the middle of the 
pipe. In the table below, the relative importance of the different heat transfer 
mechanisms in the saturated heat pipe.

It is seen that, at normal operating conditions, vapor mass transfer (and its 
associated phase changes) is the completely dominating mechanism by which the 
heat pipe transfers heat.

 RESULTS FROM THE ENERGY BALANCE EVALUATION GROUP

PROCESS HEAT TRANSFER RATE / W

Conductive heat transfer in casing 4·10-5

Conductive heat transfer in wick 3·10-5

Latent heat transfer in cavity 30
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Modeling Instructions: Heat Pipe with Accurate Liquid and Gas 
Properties
By following the steps described below you will be able to set up a model for a 
Heat Pipe, analyze it at operating conditions, and see the importance of liquid 
water in the porous wick.

Model Wizard

Note: These instructions are for the user interface on Windows but apply, with 
minor differences, also to Linux and macOS.

1 To start the software, double-click the COMSOL icon on the desktop. When 
the software opens, choose to use the Model Wizard to create a new COMSOL 
Multiphysics model, or choose Blank Model to create one manually. For this 
tutorial, click the Model Wizard button.
If COMSOL Multiphysics is already open, you can start the Model Wizard by 
choosing  New from the File menu and then click  Model Wizard.

The Model Wizard guides you through the first steps of setting up a model. The 
next window lets you choose the dimension of the modeling space.
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2 In the Model Wizard window, click 
 2D Axisymmetric.

3 In the Select Physics tree, select 
Fluid Flow>Single-Phase Flow>Laminar 
Flow (spf).

4 Click Add.
5 In the Select Physics tree, select 

Fluid Flow>Porous Media and Subsurfac
e Flow>Brinkman Equations (br).

6 Click Add.
7 In the Select Physics tree, select 

Heat Transfer>Porous 
Media>Heat Transfer in Porous Media (
ht).

8 Click Add.
9 Click  Study.
10In the Select Study tree, select 

General Studies>Stationary.
11Click  Done.

Global Definit ions

Start by reading in a set of parameters defining the dimensions and specific 
properties.

PARAMETERS

1 In the Model Builder window, under Global Definitions click Parameters 1.
2 In the Settings window for Parameters, locate the Parameters section.
3 Click  Load from File.
4 Browse to the model’s Application Libraries folder and double-click the file 
heat_pipe_parameters.txt.
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Geometry

Build up the geometry using a sector of a circle, three rectangles and a mirror 
plane.

CIRCLE 1
1 In the Geometry toolbar, click  Circle.
2 In the Settings window for Circle, locate the Size and Shape section.
3 In the Radius text field, type r_outer.
4 In the Sector angle text field, type 90.
5 Locate the Position section. In the z text field, type length/2.
6 Click to expand the Layers section. In the table, enter the following settings:

LAYER NAME THICKNESS (M)

Layer 1 w_casing

Layer 2 w_wick
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RECTANGLE 1
1 In the Geometry toolbar, 

click  Rectangle.
2 In the Settings window for 

Rectangle, locate the 
Size and Shape section.

3 In the Width text field, type 
r_outer + w_contact.

4 In the Height text field, type 
l_heatsource.

5 Locate the Position section. In 
the z text field, type length/
2-l_heatsource.

6 Click to expand the Layers 
section. In the table, enter the 
following settings:

7 Select the Layers to the right 
check box.

8 Clear the Layers on bottom check box.

RECTANGLE 2
1 In the Model Builder window, right-click Rectangle 1 and choose Duplicate.
2 In the Settings window for Rectangle, locate the Size and Shape section.
3 In the Width text field, type r_outer.
4 Locate the Position section. In the z text field, type length/
2-l_heatsource*2.

5 Locate the Layers section. In the table, enter the following settings:

LAYER NAME THICKNESS (M)

Layer 1 w_casing + 
w_contact

Layer 2 w_wick

LAYER NAME THICKNESS (M)

Layer 1 w_casing

Layer 2 w_wick
62 | 



RECTANGLE 3
1 Right-click Rectangle 2 and choose Duplicate.
2 Locate the Size and Shape section. In the Height text field, type length/
2-l_heatsource*2

3 In the Settings window for Rectangle, locate the Position section.
4 In the z text field, type 0.

At this point, the geometry primitives for the upper half of the heat pipe has been 
added, go ahead and add a mirror plane to obtain a complete heat pipe.

MIRROR 1
1 In the Geometry toolbar, click 

 Transforms and choose 
Mirror.

2 Click in the Graphics window 
and then press Ctrl+A to select 
all objects.

3 In the Settings window for 
Mirror, locate the Input 
section.

4 Select the Keep input objects 
check box.

5 Locate the 
Normal Vector to Line of Refle
ction section. In the r text field, 
type 0.

6 In the z text field, type 1.
7 In the Geometry toolbar, click  Build All Objects.
8 In the Graphics window, click  Zoom Extents.
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MESH CONTROL EDGES 1
1 In the Geometry toolbar, click 

 Virtual Operations and 
choose Mesh Control Edges.
We will use a quadrilateral 
mesh for the middle part of the 
heat pipe, and triangular mesh 
for the ends. To facilitate this 
mesh transition we define mesh 
control edges, which can be 
referenced during meshing, 
while not contributing to 
splitting of domains in other 
contexts.

2 In the Graphics window, select 
Boundaries 9, 13, 25, 29, 38, 
and 42 by clicking in 
accordance with the figure on 
the right. Verify that the 
selected edges match in the Settings window. In case of trouble, ensure sure that 
Activate Selection slider button is active (green).

IGNORE EDGES 1
1 In the Geometry toolbar, click 

 Virtual Operations and choose 
Ignore Edges.
Analogously, we want to ignore some 
other edges completely, not only during 
meshing.

2 With the Input selection active in Settings 
window for Ignore Edges, select 
Boundaries 5, 7, 11, 13, 17, 19, 23, and 
24 in the Graphics window.
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IGNORE EDGES 2
1 In the Geometry toolbar, click 

 Virtual Operations and choose 
Ignore Edges.

2 Select Boundaries 12, 14, 18, and 19.
3 In the Settings window for Ignore Edges, 

locate the Input section.
4 Clear the Ignore adjacent vertices check 

box.

IGNORE VERTICES 1
1 In the Geometry toolbar, click 

 Virtual Operations and choose 
Ignore Vertices.

2 Select Points 9, 10, 12, and 13.
3 In the Geometry toolbar, click  Build All.

It is a good practice to introduce explicit selections 
with descriptive names, these will help when 
making selections in the physics interfaces later on. 
Therefore, define selections for the three domains, 
and a handful of boundaries of interest.

VAPOR CAVITY

1 In the Geometry toolbar, click  Selections and choose Explicit Selection.
2 Select Domains 3 and 4.
3 In the Settings window for Explicit Selection, type Vapor Cavity in the Label 

text field.

POROUS COPPER WICK

1 In the Geometry toolbar, click  Selections and choose Explicit Selection.
2 Select Domains 2 and 5.
3 In the Settings window for Explicit Selection, type Porous Copper Wick in the 

Label text field.

SOLID COPPER TUBE CASING

1 In the Geometry toolbar, click  Selections and choose Explicit Selection.
2 Select Domains 1 and 6.
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3 In the Settings window for Explicit Selection, type Solid Copper Tube 
Casing in the Label text field.

HEAT SINK

1 In the Geometry toolbar, click  Selections and choose 
Explicit Selection.

2 In the Settings window for Explicit Selection, type Heat Sink in 
the Label text field.

3 Locate the Entities to Select section. From the 
Geometric entity level list, choose Boundary.

4 Select Boundary 21.

HEAT SOURCE

1 In the Geometry toolbar, click  Selections and choose 
Explicit Selection.

2 In the Settings window for Explicit Selection, locate the 
Entities to Select section.

3 From the Geometric entity level list, choose Boundary.
4 Select Boundary 20.
5 In the Label text field, type Heat Source.

CROSS SECTION OF CAVITY

1 In the Geometry toolbar, click  Selections and choose 
Explicit Selection.

2 In the Settings window for Explicit Selection, type Cross 
Section of Cavity in the Label text field.

3 Locate the Entities to Select section. From the 
Geometric entity level list, choose Boundary.

4 Select Boundary 5.

CROSS SECTION OF WICK

1 In the Geometry toolbar, click  Selections and choose 
Explicit Selection.

2 In the Settings window for Explicit Selection, type Cross 
Section of Wick in the Label text field.

3 Locate the Entities to Select section. From the 
Geometric entity level list, choose Boundary.
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4 Select Boundary 10.

CROSS SECTION OF CASING

1 In the Geometry toolbar, click  Selections and choose 
Explicit Selection.

2 In the Settings window for Explicit Selection, type Cross 
Section of Casing in the Label text field.

3 Locate the Entities to Select section. From the 
Geometric entity level list, choose Boundary.

4 Select Boundary 13.

INNER WICK BOUNDARY

1 In the Geometry toolbar, click  Selections and choose 
Explicit Selection.

2 In the Settings window for Explicit Selection, type Inner Wick 
Boundary in the Label text field.

3 Locate the Entities to Select section. From the 
Geometric entity level list, choose Boundary.

4 Select Boundaries 8 and 9.

ALL WICK BOUNDARIES

1 In the Geometry toolbar, click  Selections and choose 
Explicit Selection.

2 In the Settings window for Explicit Selection, type All Wick 
Boundaries in the Label text field.

3 Locate the Entities to Select section. From the 
Geometric entity level list, choose Boundary.

4 Select Boundaries 8, 9, 11 and 12.

Next, a union selection of the cross sections is created. Those cross sections have 
no physical importance and will only be used for analysis in the postprocessing 
stage. Therefore, hide them during the setup of the model.

ALL CROSS SECTIONS

1 In the Geometry toolbar, click  Selections and choose Union Selection.
2 In the Settings window for Union Selection, type All Cross Sections in the 

Label text field.
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3 Locate the Geometric Entity Level section. From the Level list, choose 
Boundary.

4 Locate the Input Entities section. Click  Add. Choose (holding the Ctrl key 
allows you to make multiple choices):
- Cross Section of Cavity.
- Cross Section of Wick.
- Cross Section of Casing.

5 Click OK.

HIDE FOR GEOMETRY 1
1 In the Model Builder window, expand the Component 1 (comp1)>Definitions 

node.
2 Right-click View 1 and choose Hide for Geometry.
3 In the Settings window for Hide for Geometry, locate the Selection section.
4 From the Geometric entity level list, choose Boundary.
5 From the Selection list, choose All Cross Sections.

Mesh 1

The following steps will set up a mesh with its element size controlled by a global 
parameter, and use a different mesh for the middle segment of the heat pipe.

MAPPED 1
1 In the Mesh toolbar, click  Mapped.
2 In the Settings window for Mapped, locate the 

Domain Selection section.
3 From the Geometric entity level list, choose Domain.
4 Select Domains 4, 7–9, 11, and 12 only.

DISTRIBUTION 1
1 Right-click Mapped 1 and choose Distribution.
2 In the Settings window for Distribution, locate the 

Distribution section.
3 From the Distribution type list, choose Predefined.
4 In the Number of elements text field, type length/r_outer/mesh_factor.
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5 In the Element ratio text field, type 10.
6 Select the Symmetric distribution check box.
7 Click  Build Selected.

FREE TRIANGULAR 1
In the Mesh toolbar, click  Free Triangular.

SIZE

1 In the Model Builder window, click Size.
2 In the Settings window for Size, locate the Element Size section.
3 Click the Custom button.
4 Locate the Element Size Parameters section. In the Maximum element size text 

field, type 0.9*min(w_casing, w_wick)*mesh_factor.
5 In the Minimum element size text field, type 
0.3*min(w_casing, w_wick)*mesh_factor.

BOUNDARY LAYERS 1
1 In the Mesh toolbar, click  Boundary Layers.
2 In the Settings window for Boundary Layers, locate the 

Domain Selection section.
3 From the Geometric entity level list, choose Domain.
4 Select Domains 2–5 and 8–11 only.

BOUNDARY LAYER PROPERTIES

1 In the Model Builder window, click 
Boundary Layer Properties.

2 In the Selection drop box, choose “All Wick Boundaries”.
3 Click  Build All.

Materials

We need to add materials for the metal casing and the wick, as well as for the 
working fluid (both in gaseous and liquid form). Copper will be added from the 
built-in materials. For water vapor and liquid water, two thermodynamic systems 
are created, from which you will then generate materials. Note that we need to add 
copper to global materials for it to be accessible in the porous material node, which 
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will be added to Component 1. To use this global Copper material in Component 
1 for the Solid Copper Tube Casing domain selection, a material link will be 
added.

Add Material

1 In the Home toolbar, click  Windows and choose 
Add Material from Library.

2 Go to the Add Material window.
3 In the tree, select Built-in>Copper.
4 Click  Add to Global Materials.

Global Definit ions

For water vapor we will use an ideal gas model, for liquid water we will use the 
IAPWS model.

THERMODYNAMIC SYSTEM FOR WATER VAPOR

1 In the Model Builder window, right-click Global Definitions and choose 
Thermodynamics>Thermodynamic System.

2 Click Next in the window toolbar.
3 In the Species list, select water (7732-18-5, H2O).
4 Click  Add Selected.
5 Click Next in the window toolbar.
6 From the Gas phase model list, choose Ideal gas.
7 Click Finish in the window toolbar.
8 In the Model Builder window, under Global Definitions>Thermodynamics 

right-click Gas System 1 (pp1) and choose Generate Material.
9 Click Next in the window toolbar three times (until you come to the Define 

Material window).
10From the Component list, choose Global, and then click Finish.

THERMODYNAMIC SYSTEM FOR LIQUID WATER

1 In the Model Builder window, under Global Definitions right-click 
Thermodynamics and choose Thermodynamic System.
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2 From the drop down list, choose Vapor-liquid.
3 Click Next in the window toolbar.
4 In the Species list, select water (7732-18-5, H2O).
5 Click  Add Selected.
6 Click Next in the window toolbar, and then Finish.

PROPERTIES OF WATER

Some of the boundary conditions need physical properties of water. These can be 
generated from the Thermodynamic system.
1 In the Model Builder window, under Global Definitions>Thermodynamics 

right-click Vapor-Liquid System 1 (pp2) and choose Species Property.
2 From the Amount base unit list, choose kg.
3 From the list, click  Add Selected, for each of:

- Heat of vaporization (J/kg)
- Ln vapor pressure, Pa

4 Click Next in the window toolbar.
5 Choose Liquid, and click Next.
6 Click  Add All, and click Next.
7 Click Finish in the window toolbar.

VAPOR PRESSURE OF WATER

For convenience, a helper function is set up, allowing access to the vapor pressure 
of water from the generated function (which returns the natural logarithm of the 
vapor pressure measured in Pascal).
1 In the Home toolbar, click  Functions and choose Global>Analytic.
2 In the Settings window for Analytic, type Vapor pressure of water in the 

Label text field.
3 In the Function name text field, type pH2O.
4 Locate the Definition section. In the Expression text field, type 
exp(LnVaporPressure_water22(T)).

5 In the Arguments text field, type T.
6 Locate the Units section. In the Arguments text field, type K.
7 In the Function text field, type Pa.
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8 Locate the Plot Parameters section. In the table, enter 
the following settings:

9 Optionally, click Plot to inspect the vapor pressure 
curve.

LIQUID WATER MATERIAL

1 Right-click Vapor-Liquid System 1 (pp2) and choose Generate Material.
2 From the list, choose Liquid, and click Next in the window toolbar, three times.
3 Click Finish.

FLUID IN WICK

Two cases will be investigated: a dry wick and a saturated wick. A material switch 
is added so that later interfaces can refer to this switch, which can either refer to 
vapor or liquid. Its state will be controlled from the Study nodes.
1 In the Model Builder window right-click Global Definitions>Materials and 

choose Material Switch.
2 In the Settings window for Material Switch, type 
Fluid in wick in the Label text field.

3 In the Model Builder window, right-click 
Gas: water 1 (pp1mat1) and choose Copy.

4 In the Model Builder window, right-click 
Fluid in wick (sw1) and choose Paste Material.

5 In the Model Builder window, right-click 
Liquid: water 1 (pp2mat1) and choose Copy.

6 In the Model Builder window, right-click 
Fluid in wick (sw1) and choose Paste Material.

Materials

Add a Porous Material for use in the wick, two sub-features are added to the 
Porous Material node, one for the fluid, and one for the solid.

ARGUMENT LOWER LIMIT UPPER LIMIT

T 273.15 373.15
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POROUS MATERIAL 1
1 In the Model Builder window, 

under Component 1 (comp1) 
right-click Materials and choose 
More Materials>Porous Material.

2 In the Settings window for 
Porous Material, locate the 
Geometric Entity Selection section.

3 From the Selection list, choose 
Porous Copper Wick.

FLUID 1
1 Right-click Porous Material 1 (poromat1) and choose Fluid.
2 In the Settings window for Fluid, locate the Fluid Properties section.
3 From the Material list, choose Fluid in wick.

SOLID 1
1 In the Model Builder window, right-click Porous Material 1 (poromat1) and 

choose Solid.
2 In the Settings window for Solid, locate the Solid Properties section.
3 In the θs text field, type 1-wick_porosity.

The material for the wick is now defined, continue to add links to water vapor and 
copper.

WATER VAPOR

1 In the Model Builder window under Component 1, right-click Materials and 
choose More Materials>Material Link.

2 In the Settings window for Material Link, type Water Vapor in the Label text 
field.

3 In the Settings window for Material Link, locate the 
Geometric Entity Selection section.

4 From the Selection list, choose Vapor Cavity.
5 Locate the Link Settings section. From the Material list, choose 

Gas: water 1 (pp1mat1).
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COPPER METAL

1 Right-click Materials (under Component 1) and choose 
More Materials>Material Link.

2 In the Settings window for Material Link, type Copper Metal in the Label text 
field.

3 In the Settings window for Material Link, locate the 
Geometric Entity Selection section.

4 From the Selection list, choose Solid Copper Tube Casing.

Now that the geometry, selections and materials are in place, go on to set up the 
physics.

Multiphysics

NONISOTHERMAL FLOW 1 AND 2
1 In the Physics toolbar, click  Multiphysics Couplings and choose 

Domain>Nonisothermal Flow.
2 Repeat the previous step, and in the Settings window for Nonisothermal Flow 

2, locate the Coupled Interfaces section.
3 From the Fluid flow list, choose Brinkman Equations (br).

Laminar Flow

1 In the Model Builder window, under Component 1 (comp1) click 
Laminar Flow (spf).

2 In the Settings window for Laminar Flow, locate the Domain Selection section.
3 From the Selection list, choose Vapor Cavity.
4 Locate the Physical Model section. From the Compressibility list, choose 

Compressible flow (Ma<0.3).
5 In the pref text field, type p_ref.

INLET 1
A pressure condition is applied on the cavity boundary, it is set equal to the vapor 
pressure of water. By not suppressing backflow vapor is allowed to enter at the hot 
side and exit at the cold side.
74 | 



1 In the Physics toolbar, click 
 Boundaries and choose 

Inlet.
2 In the Settings window for 

Inlet, locate the 
Boundary Selection section.

3 From the Selection list, choose 
Inner Wick Boundary.

4 Locate the 
Boundary Condition section. 
From the list, choose Pressure.

5 Locate the 
Pressure Conditions section. 
In the p0 text field, type 
pH2O(T)-p_ref.

6 Clear the Suppress backflow 
check box.

INITIAL VALUES 1
1 In the Model Builder window under Component 1>Laminar Flow, click 

Initial Values 1.
2 In the Settings window for Initial Values, locate the Initial Values section.
3 In the p text field, type p_ref.

Brinkman Equations

1 In the Model Builder window, under Component 1 (comp1) click 
Brinkman Equations (br).

2 In the Settings window for Brinkman Equations, locate the Domain Selection 
section.

3 From the Selection list, choose Porous Copper Wick.
4 Locate the Physical Model section. From the Compressibility list, choose 

Compressible flow (Ma<0.3).
5 In the pref text field, type p_ref.
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POROUS MATRIX 1
1 In the Model Builder window, under 

Component 1 (comp1)>Brinkman Equations (br)>Porous Medium 1 click 
Porous Matrix 1.

2 In the Settings window for Porous Matrix, locate the Matrix Properties section.
3 From the κ list, choose User defined. In the associated text field, type 
wick_permeability.

4 From the Fluid material list, choose Fluid in Wick (sw1).
5 Locate the Porous Matrix Properties section. From the κ list, choose 

User defined. In the associated text field, type wick_permeability.

INLET 1
The mass flux of water through the cavity–wick interface must be equal in both 
the Laminar Flow interface, as well as the Brinkman Equations interface. Using 
the ratios of densities between vapor and liquid, set a velocity boundary condition 
on the wick.
1 In the Physics toolbar, click  Boundaries and choose Inlet.
2 In the Settings window for Inlet, locate the Boundary Selection section.
3 From the Selection list, choose Inner Wick Boundary.
4 Locate the Velocity section. Click the Velocity field button.
5 Specify the u0 vector as

PRESSURE POINT CONSTRAINT 1
1 In the Physics toolbar, click  Points and choose Pressure Point Constraint.

Apply a pressure constraint of 0[Pa] to the point on the 
r axis at the interface between the wick and the casing.

2 Select Point 9 only.
3 In the Settings window for Pressure Point Constraint, 

locate the Pressure Constraint section.
4 In the p0 text field, type 0[Pa].

u*spf.rho/br.rho r

w*spf.rho/br.rho z
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Heat Transfer in Porous Media

In the Model Builder window, under Component 1 (comp1) click 
Heat Transfer in Porous Media (ht).

SOLID 1
1 In the Physics toolbar, click  Domains and choose Solid.
2 In the Settings window for Solid, locate the Domain Selection section.
3 From the Selection list, choose Solid Copper Tube Casing.

FLUID 1
1 In the Physics toolbar, click  Domains and choose Fluid.
2 In the Settings window for Fluid, locate the Domain Selection section.
3 From the Selection list, choose Vapor Cavity.

POROUS MATRIX 1
Use copper as the solid phase in the porous material. Because the material contains 
properties for the dense bulk material, you need to specify that the material 
properties are bulk properties, and therefore need to be scaled by the porosity.
1 In the Model Builder window, under Porous Medium 1, click Porous Matrix 1.
2 Locate the Matrix Properties section. From the Define list, choose 

Solid phase properties.

Next specify the boundary condition corresponding to the heat source.

HEAT FLUX 1
1 In the Physics toolbar, click  Boundaries and choose Heat Flux.
2 In the Settings window for Heat Flux, locate the Boundary Selection section.
3 From the Selection list, choose Heat Source.
4 Locate the Heat Flux section. In the q0 text field, type phi_in.

HEAT FLUX 2
The boundary condition for the heat sink is set up analogously, but with a 
convective heat-flux condition. That is, the heat flux out of the pipe through the 
heat sink is proportional to the temperature difference between the heat sink and 
the external environment. The magnitude of this proportionality constant (the 
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heat transfer coefficient) depends on external flow conditions such as the presence 
of an external fan, the external surface area, and the geometry of fins (if present).
1 In the Physics toolbar, click  Boundaries and choose Heat Flux.
2 In the Settings window for Heat Flux, locate the Boundary Selection section.
3 From the Selection list, choose Heat Sink.
4 Locate the Heat Flux section. Choose Convective heat flux from the choices of 

Flux type.
5 In the h text field, type h_conv.

BOUNDARY HEAT SOURCE 1
The heat associated with the phase change of water, removes heat at the hot side 
(evaporation) and contributes heat at the cold side (condensation), the amount of 
energy involved is the heat of vaporization. Add a boundary heat source at the 
cavity/wick interface for this process.
1 In the Physics toolbar, click  Boundaries and choose 

Boundary Heat Source.
2 In the Settings window for Boundary Heat Source, locate the 

Boundary Selection section.
3 From the Selection list, choose Inner Wick Boundary.
4 Locate the Boundary Heat Source section. In the Qb text field, type 
(u*spf.nr+w*spf.nz)*HeatOfVaporization_water21(T)*spf.rho.

Study 1

1 In the Model Builder window, click Study 1.
2 In the Settings window for Study, type Study 1 - Dry Wick in the Label text 

field.

MATERIAL SWEEP

In order to select the state of our material switch “Fluid in Wick” to correspond 
to the dry case, a material sweep is added to the study, but is only given a single 
case, the index (1) of our first material in the switch, “Gas: water 1”.
1 In the Study toolbar, click  Material Sweep.
2 In the Settings window for Material Sweep, locate the Study Settings section.
3 Click  Add.
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4 In the table, enter the following settings:

STEP 1: STATIONARY

1 In the Model Builder 
window, under Study 1 
click Step 1: Stationary.

2 In the Settings window for 
Stationary, locate the 
Physics and 
Variables Selection 
section.

3 In the table, clear the 
Solve for check boxes for 
Laminar Flow (spf) and 
Brinkman Equations (br).

4 In the Study toolbar, click  Compute.

Once the solver is done, look at the temperature profile along the heat pipe for 
this “dry” case.

Results

Edit the plot groups to create Figure 9.

TEMPERATURE, 3D (HT) - DRY WICK

1 In the Settings window for 3D Plot Group, type Temperature, 3D (ht) - 
Dry Wick in the Label text field.

2 Click to expand the Title section. From the Title type list, choose Manual.
3 In the Title text area, type Temperature.
4 Locate the Color Legend section. Select the 

Show maximum and minimum values check box.
5 Select the Show units check box.

SWITCH CASES CASE NUMBERS

Fluid in wick (sw1) User defined 1
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SURFACE

1 In the Model Builder window, expand the Temperature, 3D (ht) - Dry Wick 
node, then click Surface.

2 In the Settings window for Surface, locate the Expression section.
3 From the Unit list, choose degC.
4 In the Temperature, 3D (ht) - Dry Wick toolbar, click  Plot.

This is Figure 9 from the earlier Results section. We note that for the parameters 
at hand, the pipe would get quite hot. Remove one of the plots before moving 
on.

ISOTHERMAL CONTOURS (HT)
In the Model Builder window, right-click Isothermal Contours (ht) and choose 
Delete.

Add Study

Let us now solve the model for the normal case, with actual liquid in the wick.
1 In the Home toolbar, click  Windows and choose Add Study.
2 In the Add Study window, select General Studies>Stationary in the Select Study 

tree.
3 Click  Add Study.

Study 2 -  Saturated Wick

1 In the Model Builder window, click Study 2.
2 In the Settings window for Study, type Study 2 - Saturated Wick in the 

Label text field.

MATERIAL SWEEP

1 In the Study toolbar, click  Material Sweep.
2 In the Settings window for Material Sweep, locate the Study Settings section.
3 Click  Add.
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4 In the table, enter the following settings:

STEP 2: STATIONARY 1
Study 2 is solved in two steps, first without Brinkman Equations, and then with 
all interfaces active. Solving in this order will give the Brinkman Equations an 
initial guess close to the final solution, making the process more robust and 
efficient.
In the Model Builder window, under Study 2 - Saturated Wick right-click 
Step 1: Stationary and choose Duplicate.

STEP 1: STATIONARY

1 In the Settings window for the first step in Study 2: “Step 1: Stationary”, locate 
the Physics and Variables Selection section.

2 In the table, clear the Solve for check box for Brinkman Equations (br).
3 In the Study toolbar, click  Get Initial Value.

By requesting initial values, default plot groups are created which we can now 
modify.

Results

VELOCITY (SPF) AND TEMPERATURE (HT)
1 In the Settings window for 2D Plot Group Velocity (spf), add and 
Temperature (ht) in the Label text field.

2 Click to expand the Title section. From the Title type list, choose Manual.
3 In the Title text area, type Fluid Velocity and Temperature.
4 Locate the Color Legend section. Select the Show units check box.

SURFACE 1 - FLUID VELOCITY, LG(|U|)
1 In the Model Builder window, expand the Velocity (spf) and Temperature (ht) 

node, then click Surface.
2 In the Settings window for Surface, type Surface 1 - Fluid Velocity, 
lg(|u|) in the Label text field.

SWITCH CASES CASE NUMBERS

Fluid in wick (sw1) User defined 2
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3 Locate the Expression section. In the Expression text field, type 
log10(ht.uz^2 + ht.ur^2)/2.

4 Locate the Coloring and Style section. Click  Change Color Table. 

5 In the Color Table dialog box, select Linear > Cividis in the tree.
6 Click OK.

SURFACE 2 - TEMPERATURE

1 Under Velocity (spf) and Temperature, right-click 
Surface 1 - Fluid velocity, lg(|u|), and choose Duplicate.

2 In the Settings window for Surface, type Surface 2 - Temperature in the 
Label text field.

3 In the Settings window for Surface, locate the Expression section.
4 In the Expression text field, type T.
5 Locate the Expression section. From the Unit list, choose degC.
6 Locate the Coloring and Style section. From the Color table list, choose 

HeatCamera.

DEFORMATION 1
Use a deformation to allow showing two plots side by side.
1 Right-click Surface 2 - Temperature and choose Deformation.
2 In the Settings window for Deformation, locate the Expression section.
3 In the r component text field, type r_outer.
4 Locate the Scale section. Select the Scale factor check box.
5 In the associated text field, type 3.

ARROW SURFACE 1
1 In the Model Builder window, right-click Velocity (spf) and Temperature (ht) 

and choose Arrow Surface.
2 In the Settings window for Arrow Surface, type Arrow Surface 1 - Vapor 
flow in the Label text field.

3 Locate the Arrow Positioning section. Find the r grid points subsection. In the 
Points text field, type 9.

4 Locate the Coloring and Style section. From the Arrow length list, choose 
Logarithmic.

5 Select the Scale factor check box.
6 In the associated text field, type 0.005.
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7 From the Color list, choose Black.

ARROW SURFACE 1 - VAPOR FLOW 1
Right-click Arrow Surface 1 - Vapor flow and choose Duplicate.

ARROW SURFACE 2 - LIQUID FLOW

1 In the Settings window for Arrow Surface, type Arrow Surface 2 - Liquid 
flow in the Label text field.

2 Locate the Expression section. In the r component text field, type u2.
3 In the z component text field, type w2.
4 Locate the Coloring and Style section. Enter the value 50 as the Scale factor.
5 From the Color list, choose Blue.

LINE 1 - MATERIAL BOUNDARIES

1 In the Model Builder window, right-click Velocity (spf) and Temperature (ht) 
and choose Line.

2 In the Settings window for Line, type Line 1 - Material Boundaries in the 
Label text field.

3 Locate the Expression section. In the Expression text field, type 1.
4 Locate the Coloring and Style section. From the Coloring list, choose Uniform.
5 From the Color list, choose Black.

DEFORMATION 1
1 Right-click 

Line 1 - Material Bound
aries and choose 
Deformation.

2 In the Settings window 
for Deformation, locate 
the Expression section.

3 In the r component text 
field, type r_outer.

4 Locate the Scale section. 
Select the Scale factor 
check box.

5 In the associated text field, type 3, and click  Plot.
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Study 2 -  Saturated Wick

SOLVER CONFIGURATIONS

1 In the Model Builder window, expand the 
Study 2 - Saturated Wick>Solver Configurations>Solution 4 (sol4) node.

2 Right-click Stationary Solver 1 and choose Fully Coupled.
3 In the Settings window for Fully Coupled, click to expand the 

Results While Solving section.
4 Select the Plot check box, select “Velocity (spf) and Temperature (ht)” as the 

Plot group.
5 In the Model Builder window, right-click Stationary Solver 2 and choose 

Fully Coupled.
6 In the Settings window for Fully Coupled, locate the Results While Solving 

section.
7 Select the Plot check box, select “Velocity (spf) and Temperature (ht)” as the 

Plot group.

Results

To aid the analysis of the results, create a series of line integrals of the heat flux 
across boundaries, in an Evaluation Group. Let the line integrals run across the 
middle section of the pipe (on the r-axis), and the contact surfaces for heat source 
and heat sink.

ENERGY BALANCE

1 In the Results toolbar, click  Evaluation Group.
2 In the Settings window for Evaluation Group, type Energy Balance in the 

Label text field.
3 Locate the Data section. From the Dataset list, choose 

Study 2 - Saturated Wick/Parametric Solutions 2 (sol6).
4 Locate the Transformation section. Select the Transpose check box.

HEAT SINK

1 Right-click Energy Balance and choose Integration>Line Integration.
2 In the Label text field, type Heat Sink.
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3 Locate the Selection section. From the Selection list, choose Heat Sink.
4 Click Replace Expression in the upper-right corner of the Expressions section. 

From the menu, choose 
Component 1 (comp1)>Heat Transfer in Porous Media>Boundary fluxes>ht.
ndflux - Normal conductive heat flux - W/m².

5 Locate the Expressions section. In the table, enter the following settings:

HEAT SOURCE

1 Right-click Heat Sink and choose Duplicate.
2 In the Settings window for Line Integration, type Heat Source in the Label 

text field.
3 Locate the Selection section. From the Selection list, choose Heat Source.
4 Locate the Expressions section. In the table, enter the following settings:

CASING

1 Right-click Heat Source and choose Duplicate.
2 In the Settings window for Line Integration, type Casing in the Label text 

field.
3 Locate the Selection section. From the Selection list, choose 

Cross Section of Casing.
4 Locate the Expressions section. In the table, enter the following settings:

WICK

1 Right-click Casing and choose Duplicate.
2 In the Settings window for Line Integration, type Wick in the Label text field.
3 Locate the Selection section. From the Selection list, choose 

Cross Section of Wick.

EXPRESSION UNIT DESCRIPTION

ht.ndflux W sink: ndflux

EXPRESSION UNIT DESCRIPTION

ht.ndflux W source: ndflux

EXPRESSION UNIT DESCRIPTION

ht.ndflux W casing: ndflux
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4 Locate the Expressions section. In the table, enter the following settings:

CAVITY

1 Right-click Wick and choose Duplicate.
2 In the Settings window for Line Integration, type Cavity in the Label text 

field.
3 Locate the Selection section. From the Selection list, choose 

Cross Section of Cavity.
4 Locate the Expressions section. In the table, enter the following settings:

LATENT HEAT FLUX FROM PHASE CHANGE

To investigate how the phase change along the wick transfers thermal energy, 
create a line graph plotting this heat flux along the cavity–wick boundary.
1 In the Results toolbar, click  1D Plot Group.
2 In the Settings window for 1D Plot Group, type Latent heat flux from 
phase change in the Label text field.

LINE GRAPH 1
1 Right-click Latent heat flux from phase change and choose Line Graph.
2 In the Settings window for Line Graph, locate the Data section.
3 From the Dataset list, choose Study 2 - Saturated Wick/

Parametric Solutions 2 (sol6).
4 Locate the Selection section. From the Selection list, choose 

Inner Wick Boundary.
5 Locate the y-Axis Data section. In the Expression text field, type (u*spf.nr + 
w*spf.nz)*spf.rho*HeatOfVaporization_water21(T).

6 Locate the y-Axis Data section. Select the Description check box.
7 In the associated text field, type (<B>u</B>\cdot<B>n</B>)\rho\DELTA 
H<sub>vap</sub>.

EXPRESSION UNIT DESCRIPTION

ht.ndflux W wick: ndflux

EXPRESSION UNIT DESCRIPTION

ht.ndflux W cavity: ndflux

w*spf.rho*HeatOfVaporization_water21
(T)

W cavity: latent heat
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8 Click to expand the Title section. From the Title type list, choose Manual.
9 In the Title text area, type Latent heat flux from phase change.
10Locate the x-Axis Data section. From the Parameter list, choose Expression.
11In the Expression text field, type z.

Study 2 -  Saturated Wick

In the Home toolbar, click  Compute.

Results

We can analyze the results, first by numbers, by looking at line integrals defined 
earlier.

ENERGY BALANCE

1 In the Model Builder window, under Results click Energy Balance.
2 In the Energy Balance toolbar, click  Evaluate.

Note how the heat fluxes across the heat sink and heat source match with opposite 
signs, and how close the magnitude of “cavity: latent heat” is to this number.
Next apply some finishing touches to the 3D plot of the temperature.

TEMPERATURE, 3D (HT)
1 In the Model Builder window, click Temperature, 3D (ht).
2 In the Settings window for 3D Plot Group, in the Title section, change the 

Title type list choice to Manual.
3 In the Title text area, type Temperature.
4 Locate the Color Legend section. Select the 

Show maximum and minimum values check box.
5 Select the Show units check box.

SURFACE

1 In the Model Builder window, expand the Temperature, 3D (ht) node, then 
click Surface.

2 In the Settings window for Surface, locate the Expression section.
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3 From the Unit list, choose degC.
4 Click  Plot.

This is Figure 10 from the results section earlier. Notice how even the temperature 
is throughout the heat pipe. Also the maximum temperature is significantly lower 
compared to the dry wick case investigated previously.
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